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OVERVIEW

Word

Processing

One of the most widely used applications software programs is a word processor. To
put your thoughts in writing, from the simplest note to the most complex book, is a
time-consuming process. Even more time-consuming is the task of editing and
retyping the document to make it perfect. There was a time when perfection in
written communication was difficult, if not impossible, to achieve. With the intro-
duction of word processing, errors should be nearly nonexistent—not because they
are not made, but because they are easy to correct. Word processors let you throw
away the correction fluid, scissors, paste, and erasers. Now, with a few keystrokes,
you can correct errors, move paragraphs, and repfint your document easily.

Definition of Word Processing

Word processing applications software is a program that helps you create any type of
written communication via a keyboard. A word processor can be used to manipulate
text data to produce a letter, a report, a memo, or any other type of correspondence.
Text data is any letter, number, or symbol that you can type on a keyboard. The
grouping of the text data to form words, sentences, paragraphs, and pages of text
results in the creation of a document. Through a word processor you can create,
modify, store, retrieve, and print part or all of a document.

Advantages of Using a Word Processor

The speed of entering text data into the computer depends on the skill of the user. If
you cannot type fast, a word processor will not improve your typing speed. However,
a word processor will make it easier to correct and change your document. Conse-
quently, your completed document will take less time to create.

Another time saver is word wrap. As you enter text you do not need to decide
where to end each line, as you do on a typewriter. When a line is full, the program
automatically wraps the text down to the next line.

WP3
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Overview: Word Processing

Where a word processor excels is in its ability to change or edit a document.
Editing involves correcting spelling, grammar, and sentence-structure errors. As
you enter characters using the keyboard, they are displayed on the screen and stored
electronically in the computer’s main memory. As you find errors, you can elec-
tronically delete and correct them. Once the document is the way you want it to
appear, it can be permanently saved on a disk and printed on paper. Good-bye,
correction fluid!

In addition to editing a document, you can easily revise or update it by insert-
ing or deleting text. For example, a document that lists prices can easily be updated
to reflect new prices. A document that details procedures can be revised by deleting
old procedures and inserting new ones. This is especially helpful when a document
is used repeatedly. Rather than recreating the whole document, you change only the
parts that need to be revised.

Revision also includes the rearrangement of pieces or blocks of text. For ex-
ample, while writing a report, you may decide to change the location of a single
word or several paragraphs or pages of text. You can do it easily by cutting or
removing selected text from one location, then pasting or placing the selected text
in another location. Blocks of text can also be copied from one area of the document
to another. This is a real advantage when the text includes many recurring phrases
or words.

Combining text in another file with text in your document is another advan-
tage of word processors. An example of this is a group term paper. Each person is
responsible for writing a section of the paper. Before printing the document, the text
for all sections, which is stored in different files, is combined to create the complete
paper. The opposite is also true. Tekt that may not be appropriate in your document
can easily be put in another file for later use.

Many word processors include additional support features to further help you
produce a perfect document. A spelling checker checks the spelling in a document
by comparing each word to those in a dictionary stored in memory. If an error is
found, the program suggests the correct spelling. A syntax checker electronically
checks grammar, phrasing, capitalization, and other types of syntax errors in a
document. A thesaurus displays alternative words that have a meaning similar or
opposite to the word you entered.

You can also easily control the appearance or format of the document. Format-
ting includes such operations as changing the line spacing and margin widths,
adding page numbers, and displaying page headers and footers. You can also quickly
change how your text is aligned with the left or right margin. For example, text can
be centered between the margins, or justified—evenly aligned on both the left and
right margins. Perhaps the most noticeable formatting feature is the ability to apply
different fonts (type styles and sizes) and text appearance changes such as bold and
italics to all or selected portions of the document. Some word processing programs
also have the ability to produce and display graphic lines and boxes. Graphic boxes
can then be used to hold text or graphic images that you place into the document.

Many word processing programs also include the WYSIWYG (“what you see is
what you get”) feature. This feature allows you to see onscreen exactly (or as close as
possible) how your document will appear when printed. This means that the effects
of your format changes are immediately displayed on the screen.

If, after reading the printed copy, you find other errors or want to revise or
reformat the document, it is easy to do. Simply reload the document file, make your
changes, and reprint the text. Now that saves time!



Word Processing Terminology i S‘mi

The following terms and definitions are generic in nature and are associated with
most word processing programs.

Block: Any group of characters, words, lines, paragraphs, or pages of text.
Bold: Produces dark or heavy print. .

Center: To center a line of text evenly between the margins.

Copy: To duplicate selected text in another location in the document.
Cut: To remove or delete selected text from an area in the document.
Document: Text-based output created by a word processing program.
Edit: To change or modify the content of the document.

Font: Type style and size.

Format: Defines how the printed document will appear; includes settings for under-
line, boldface, print size, margin settings, line spacing, and so on.

Insert: To enter new text into a document between existing text.
Justified: Text that is evenly aligned on both the left and right margins.
Paste: To place selected text in another location in the document.

Spelling checker: A support feature that checks words or the entire document for
correct spelling.

Text data: Any number, letter, or symbol you can type on a keyboard.

Thesaurus: A support feature that displays synonyms and antonyms for words in
your document.
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Word wrap: The automatic adjustment of the number of characters or words on a
line that eliminates the need to press the (or Return) key at the end of
each line.

¥
WYSIWYG: The feature that displays a document onscreen as close as possible to
how it will appear when printed.

Case Study

As a recent college graduate, you have accepted your first job as a management trainee
for the Sports Company. The Sports Company is a chain of discount sporting goods
shops located in large metropolitan areas throughout the United States. The program
emphasis is on computer applications in the area of retail management and requires
that you work in several areas of the company.

In this series of labs, you are working in the Southwest Regional office and are
responsible for setting up the credit card enrollment program and for assisting with the
monthly newsletter.

In Labs 1 and 2, you will create a letter to be sent to all new credit card recipients.
You will learn how to use the word processing program to edit and format the letter.

InLab 3, the regional office has decided to send amonthly newsletter to credit card
customers. You have been asked to design and prepare several articles for inclusion in
the newsletter.

Lab 4 demonstrates how to personalize the credit card letter by creating a form
letter and merging the recipients’ personal information such as name and address into
the form letter. You will also prepare a table and chart that summarize the gross sales
for the regional stores.
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Overview: Word Processing

Before You Begin

The following assumptions have been made:

WordPerfect 6.0 for Windows has been properly installed on the hard disk
of your computer system.

The default program settings are in effect except for the following:

1.

The Reformat Documents for Default Printer on Open setting has
been turned off. The File/Preference/Environment command can be
used to change this setting. This exception is necessary to ensure
that the procedures and figures in the text are the same for all
students and are not affected by printer settings.

The Epson FX-80 Printer must be an installed printer in WordPerfect.
The printer canbe installed through WordPerfect (File/Select Printer/
Add Printer/Windows). This printer is needed so that WordPerfect
does not format the data files to the currently selected printer.

The personal information for templates is blank. To make it blank,
choose File/Template, then select any template name. The Personal
Information dialog box is displayed. To leave the information blank,
choose OK/OK, then close the template file without saving it. This
change is necessary so that each user can enter their own personal
information into the template without having to clear a previous
user’s personal datj{i.

The data disk contains the data files needed to complete the series of
WordPerfect 6.0 for Windows labs and practice exercises. These files are
supplied by your instructor.

You have completed the Windows labs or you are already familiar with
how to use Windows.



LAB

Creating

and Editing
Documents

CASE STUDY

The Sports Company is a chain of sporting goods shops located in large
metropolitan areas across the United States. The stores are warehouse ori-
ented, discounting the retail price of most items 15 percent. They stock
sporting goods products for the major sports: team sports, racquet sports,
aerobics, golf, and winter sports.

As a recent college graduate, you have accepted a job in a management
training program for the Sports Company. The training program emphasis
is on computer applications in the area of refail management. The program
requires that you work in several areas of the company. You have been
assigned to work in the Southwest Regional Office. You will be responsible
for getting the credit card program set up and for assisting with the monthly
newsletter.

In this lab you will use WordPerfect for Windows to edit a letter to be
sent to the new credit card recipients.

Loading the WordPerfect for Windows Program

Start Windows. (If you need help, refer to Windows Lab 1 or consult your instructor
for details.)

The Windows Program Manager should display the WordPerfect Applications
window icon.

Note: If your system is set up differently, your instructor will provide alternative
instructions.

Open the WordPerfect Applications window.

The WordPerfect Applications window contains six program icons: WPWin 6.0,
Speller, Thesaurus, QuickFinder File Indexer, Kickoff, and WPWin 6.0 Installation.
Each of these represents a program that is a stand-alone application that can be run
under Windows without starting the WordPerfect 6.0 program.

COMPETENCIES

After completing this lab, you will
know how to:

1.

© O N o o & W

11.
12.
13.

. Issue a WordPerfect for

. Open a WordPerfect document.

. Move around a document.

Load the WordPerfect for
Windows program.

Windows command.
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. Delete and insert text.

. Insert and delete blank lines.
. Display hidden codes.

. Select blocks of text.

. Undelete text.

10.

Save and print a document.
Create a new document.
Change line spacing.

Exit WordPerfect for Windows.

WP7
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Lab 1: Creating and Editing

Documents

Control-menu boxes

PWin 6.0 program icon. Put your d
propriate drive for your system).
A title screen is displayed while the computer loads the WordPerfect for Win-
dows program into memory.

Exploring the WordPerfect Window

Your screen should be similar to Figure 1-1.
title bar Minimize button
Restore
WordPerfect - [Documentl] buttons
menu
bar

button
bar

power
bar

insertion point

document window

FIGURE 1-1

scroll
bars

status
bar

current font mouse pointer page line position
number indicator indicator

The WordPerfect for Windows application window is displayed. As you can see, many
of the features on the WordPerfect application window are the same as in the Win-
dows applications. Among those features are a title bar, a menu bar, control-menu
boxes, Minimize and Restore buttons, icons, scroll bars, and mouse compatibility.
You can move and size WordPerfect windows, select commands, use Help, and
switch between files and programs just like in Windows. Your knowledge of Win-
dows makes learning and using WordPerfect for Windows much easier.

Displayed below the menu bar are the button bar and the power bar. The
button bar gives quick access to program features. The power bar contains buttons
representing the most frequently used text-editing and text-layout features. You will
learn how to use these bars throughout the labs.

The large blank area below the bars is the WordPerfect for Windows document
window. This is where WordPerfect documents are created and edited. The WordPerfect
word processing program is similar to the Write application in Windows, except it is
much more powerful. The document window is currently empty and is like a blank
sheet of paper waiting for you to type on it. The insertion point is the blinking vertical
bar that shows you where the next character you type will appear.



If you have a mouse, the mouse pointer may appear as an I-beam I , an arrow R WP9
or a hand &, depending upon its location in the window. The different shapes Choosing Commands
mdlcate the different mouse capabllltles You will learn more about this shortly. from Menus

! ouse pointer is not an [-bea e

The line of information at the bottom of the screen is the status bar. It tells
you the following information:

Courier New The currently selected font (typeface and size). The font on
Regular 12 pt  your screen may be different than in Figure 1-1.

Insert An indicator that tells you which mode of text entry you are
using, Insert or Typeover.

Select An indicator that appears highlighted when text in the docu-
ment is selected. Otherwise it is displayed dim.

Pg 1 The number of the physical page where the insertion point is
located. The physical page is the area that can be printed on a
piece of paper. It is currently on page 1.

Ln 1" The vertical distance in inches between the insertion point
and the top of the page. This is the line on which the inser-
tion point rests. The insertion point is currently 1 inch from
the top of the page.

Pos 1" The horizontal location or position of the insertion point on
the line. This is measured in inches from the left edge of the
page. The insertion point is currently 1 inch from the left
edge of the page.
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The line and position settings on your screen are the default or initial WordPerfect
for Windows settings. WordPerfect comes withmany default settings, which are
generally the most commonly used settings. For example, the current position of the
insertion point at 1 inch from the left edge of the page is the default left margin
setting. The right margin default setting is 1 inch from the right edge of the page.
Other default settings include a standard paper-size setting of 8'/2 by 11 inches, tab
settings every half inch, and single line spacing. If you do not specify different
settings, WordPerfect uses the default settings.

Choosing Commands from Menus

As in other Windows applications, you communicate with WordPerfect by choosing a
menu item from the menu bar. When chosen, the selected menu bar item displays a
pull-down menu of commands from which you choose. The procedure to operate the
menu is the same as in Windows. Commands can be chosen by clicking on the menu
item or command with the mouse or by using the keyboard. If you are using a
mouse, the mouse pointer will change to an arrow to show that you can use it to
choose a command. If you are using the keyboard, you must activate the menu bar
first by pressing or (F10). Then a menu item or command can be chosen by
typing the underlined letter or by moving the highlight to the command and press-
ing («Enter].

The command to open a file is in the File menu. To open this menu,
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Lab 1: Creating and Editing

Documents

command
description

shortcut
key

" By, i ]
ellipsis

_'éiis_tgr_llgﬂmm——*
arrowhead— | | compare Document »

symbol

FIGURE 1-2

-

Keys separated with a plus
mean to hold down the first

key while

fkay; 1

pressing the second

Your screen should be similar to Figure 1-2.

Edit View Insert Layout Tools Graphics Table Window Help

Ctrl+T
Ctrl+0
Ctri+F4

Save Ctrl+S
Save Asj.. F3

QuickFinder...

Template...

Close

Document Summary...
Document Info...

Preferences...
Print... F5
Select Printer...
Exit

1 letter.wpd

2 wpwlab2.w60
3 wpwlabl.w51
4 credit.frm %

Alt+F4

£
The File pull-down menu of commands is displayed. The highlighted bar or selec-
tion cursor appears over the first command in the pull-down menu and in the menu
bar over the chosen menu item. The title bar displays a brief description of the New
command, the command the selection cursor is on in the pull-down menu.

Many of the features in the pull-down menu should be familiar to you. If a
shortcut key is available, it is displayed to the right of the command. A shortcut key
is a single key or a key combination that can be used instead of selecting the
command from the menu. The ellipsis (...) indicate that a dialog box will be dis-
played for you to specify additional information needed to carry out the command. A
dimmed command indicates the command is not available for selection until certain
other conditions are met. A check mark means that a command is on.

Another feature on the menu is the arrowhead symbol P>. This symbol means
that a cascading menu will be displayed when this command is selected. To see an
example of a cascading menu,

Choose:



Your screen should be similar to Figure 1-3. WP11
Choosing Commands

from Menus

Edit View Insert Layout Tools Graphics Table Window Help

New Ctrl+N
Template... Ctri+T
| Open... Ctr+0 B3
== (Close Ctrl+F4 _ ’ 1
Save Ctrl+S i
Save As... F3
QuickFinder...

Master Document
Compare Document
Document Summary...
Document Info...

Subdocument...
Expand Master...
Canidense Masier...

cascading menu

Preferences...

Print... F5
Select Printer...

Exit Alt+F4

letter.wpd

wpwlab2.wb0 .
wpwlab1.w51 a
credit.frm %

most recently used files

& e NS =

FIGURE 1-3

The cascading menu displays options associated with the Master Document com-
mand in the File menu. To cancel the cascading menu,

—_— 4
Press:  [(Esc]

At the bottom of the File menu, a list of the most recently used files may be
displayed. If they are not displayed, this is because your instructor has turned this
feature off.
To preview the commands a ated with each menu, display the puII -down
menu for eachbf the other me bar items. Leave the Help pull-down menu open.
The WordPerfect Help menu is similar to the Windows Help menu. To see a
listing of Help topics,

Choose:  Contents
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Lab 1: Creating and Editing
Documents

FIGURE 1-4

-
The control menu can be
opened with the keyboard by
pressing - in
an application window or
+ (7] in a document window.

-
Pressing the Help key is
the shortcut to open the Help
Contents window.

Your screen should be similar to Figure 1-4.

Help conrol menu box

Combined Peosition - Display page nunijf= T 5 e
=| File Edit View Insert Layout T Fjle Edit Bookmark Help Help
Ol alolFrelzAal e Contents .
Welcome to WordPerfect 6.0 for Windows Help buttons

search for information and to move through Help, use
the buttons along the top of the Help window.

Choose For information about

Search (Index) topics listed alphabetically

How Do | performing tasks |
Glossary meanings of terms -

Menu Commands features by menus
WordPerfect Bars topics by Feature Bar, Power
Bar. Ruler Bar. Button Bar, and

Status Bar
Keystrokes keystrokes and templates
About'WordPerect  license and program dates
New Features features new to WPWin
Other Products other WPCorp products
Macros macro commands
Coach starting the Coach
Tutorial starting the tutorial
Using Help how to use Help

The Help Contents application window displays a list of major topic areas in Help.
The first item, Search (Index), allows you to locate a specific topic quickly. You will
be using Help for information shortly. The Help buttons and other Help features
operate just like the Windows Help system.

The Help window can be closed by choosing Exit from the Help File menu, by
choosing Close from the Help control menu, by pressing + (F4 ), or by double-
clicking on the Help control-menu box. This is the same as closing Windows Help.

Using any of these methods, close the Help Contents window.

Exploring the Button Bar and the Power Bar

If you are not using a mouse, skip to the next section.

The button bar and the power bar provide mouse users with a faster and more
graphic means of entering commands. The button bar contains 12 buttons or graphics
that represent frequently used program features. The power bar contains buttons that
represent the most frequently used text-editing and text-layout features. To find out
what features the button symbols represent, you can display a description of each
button by moving the mouse pointer over the buttons. A brief description of the button
appears in the title bar. It includes a shortcut key equivalent if one is available.

Move the mouse pointer over each of the power bar and button bar button and
read the description in the title bar.

To choose a button, press the left mouse button while the mouse pointer is on
the button. The last button in the power bar is the View button. It will hide the
button bar. To use this button,

Click: ~ [E View



The button bar is no longer displayed in the window. To display the button bar
again,

Click:

Many features and commands have power bar or button bar equivalents that
are much quicker to use than the menu. Whenever appropriate, the button bar or
power bar buttons will be displayed as an alternative to a menu sequence following
the word “Click.”

Opening a File

The first draft of the credit card letter is on your data disk in a file named LETTER.
To open this file, you need to choose Open from the File menu. This command can
be chosen by using the pull-down menu, by using the shortcut key, + 0, or if
you have a mouse, by clicking on the ]ﬁ{ Open button on the power bar. Using any of
these methods,

Choose:
>

or

Click:

Your screen should be similar to Figure 1-5.
text box Open File dialog box

V%ordperfect - [Documentl - unmodified] /
le Edit View Inseft Layout Tools Graphics Table indow Help

= e\
(> wpwinB0
> wpdocs

list box

Note: The files and directories displayed on your screen will be different than those
in Figure 1-5.

WP13
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FIGURE 1-5

command buttons
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-
If you are using the
keyboard, press (¥] to display
the pull-down list of drives.
Use (¥] to highlight the drive
and press to select it.

Scroll bar

up scroll arrow

scroll box

down scroll
arrow

-

Use the scroll bar or (#) and
to scroll the list.

-
You can also double-click on
the filename to select the file
and choose OK at the same
time.

The Open File dialog box is displayed. It contains the same dialog box features
as dialog boxes in Windows: a text box, list boxes, and command buttons. It also
operates just like Windows dialog boxes. If you have a mouse, simply click on the
area you want to use, or if the option you want to select is visible, click directly on it
to select it. To move from one area to another using the keyboard, press and the
underlined letter of the area name or press until the area you want to use is
selected. Then select the option from the list by using the directional keys to move
the highlight to it.

In this dialog box, you need to enter the path and filename of the file you want
to open. As in Windows, you can type the path and name of the file in the text box or
you can choose the path and file from the list boxes. You will choose the drive and
filename from the list boxes. The filename will then be automatically entered into
the Filename text box. First you need to change the drive from the default drive to
the drive containing your data disk by selecting the appropriate drive from the
Drives list box.

Choose:  Drives
Select: a: (or the appropriate drive)

Note: 1f you get a system error message, check that your disk is properly inserted in
the drive and that the disk-drive door is completely closed. Reselect the option.

Now the filenames and directories displayed in the Filename list box are those on
your data disk in the selected drive. The list of filenames may be longer than can be
displayed in the list box. As in Wimfows, you can bring other information into view
in the box by scrolling the list. The scroll bar is displayed in a list box whenever
there is more information than can fit in the space. The scroll bar operates just like
the scroll bar in Windows. The = and 1 scroll arrows in the vertical scroll bar will
scroll the list vertically. Just as in Windows, to scroll continuously, hold down the
mouse button while pointing to a scroll arrow. You can also use the (4] and (¥) keys
to scroll the files.

The file you want to open is LETTER. If necessary scroll the Filename list box
until the filename is displayed.

Select: letter.wpd

Note: 1f the filename LETTER is not displayed in the Files list box, ask your instruc-
tor for help.

To complete the command, you need to choose the OK button. Since this is
the default button, you can choose it if you are using a keyboard by pressing («Enter).

Choose: OK



Your screen should be similar to Figure 1-6. WP15

Moving Around the
Document Window

filename

WordPerfect - [a}\letter.wpd - unmodified] [+]3]

File Edit

IDeear Preeferredd Cusstomer:

Thaanank youuu for opening aaa newwww credit carrdd accccount ?on§¥“30fopen6d
wittth The Sports Company and becorming one of ocourur most valued ile |SMayeQ|n
customers. Here's your new creeditte card! document window

Please sign your card with your usual signature. If you have an
new card, destroy it immediately. Always carry your old credit
card with you. It will identify wou vou as a Preferred Customer
and guarantees you a guick guick and convenient8%% Y** P%
szhopping experience at any of The Sports Company stores*oSd g533e
90r th## located throughout the country. We are the leading
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The file is loaded and displayed in the document window. This file contains a first
draft of the letter to new credit card customers. As you can see, it contains many
errors. You will learn how to correct these errors ig this lab.

Also notice that, in addition to the program name in the title bar, the filename
is also displayed. The “unmodified” indicator following the filename tells you that no
changes have been made to this file since it was opened or since it was last saved. As
soon as a change is made to the file, this indicator disappears.

Moving Around the Document Window

The mouse or the keyboard can be used to move through the text in the document
window. Depending upon what you are doing, the mouse is not always the quickest
means of moving; therefore if you are using the mouse, you will learn how to move
through the document using both methods. If you do not have a mouse, follow the
keyboard directions only. If you have a mouse, follow the instructions in both sec-
tions that follow.

Note: If the line and position references in the text are different than those on your
screen, refer to items 1 and 2 in the Before You Begin section in the Overview.
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You use the mouse to move the insertion point to a specific location in a
document. When you can use the mouse to move the insertion point, it
is shaped as an I-beam. When the mouse pointer is positioned in the left




WP16 margin, it changes to an arrow. This means it will highlight the text
Lab 1: Creating and Editing rather than move the insertion point.
Documents
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Be careful not to move the
mouse while clicking. If you
do, whatever text is under
the I-beam may appear
highlighted. To clear the
highlight, click without
moving the mouse.

Make sure the
(number lock) key is not on
when using the arrow keys in
the numeric keypad area. If it
is on, numbers will be
entered in the document
rather than the insertion
point moving through the
text.

Move the mouse pointer into the left margin. Move it back to the docu-
ment text.

You will learn more about this feature shortly. Make sure the pointer is
an |-beam before clicking to move the insertion point. If text appears
highlighted, click anywhere in the document where the mouse pointer is
an |-beam. To move the insertion point, position the I-beam at the loca-
tion in the text where you want to move the insertion point and click
the left mouse button.

Move to:  “y” of “you” (first line of first paragraph)

Notice that the insertion point has not moved and the status bar infor-
mation has not changed.

Click: left mouse button

The insertion point should now be positioned on either side of the “y.”

If it is positioned to the left of the “y,” this means the I-beam was
positioned more to the left side of the character when you clicked the
mouse button. The letter to the right of the insertion point is the se-
lected character, in this case the “y.” The status bar shows the new
location of the insertion point is Ln 1.38" Pos 1.9".

If it is positioned to the right of the “y,” this means the |-beam was
positioned more to the ¥ight side of the character when you clicked the
mouse button. The letter to the right of the insertion point is the se-
lected character, in this case the “o0.” The status bar shows the new
location of the insertion point is Ln 1.38" Pos 2".

Throughout the labs you will be instructed to move to a specific letter in
the text. This means to move the insertion point to the /eft side of the
character so that the character to the right is selected.

Practice using the mouse to move the insertion point to the left side of a
character by moving it to the following locations:

Move to:  “I” in “If” (first line, second paragraph)

Move to:  “c” in “country” (sixth line, second paragraph)
Move to:  “D” in “Deear” (first line of document)

The insertion point can also be moved around the window using the arrow
keys located on the numeric keypad or the directional keypad. The arrow keys
move the insertion point one character space in the direction indicated by the
arrow.

Note: Be careful to only use the keys specified as you are following the direc-
tions in this section. If you do, the instructions and figures in the text should be
the same as what you see on your screen.

Press: (6 times)



